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Power Rail Noise Analyzer Reference Design

TI Designs: TIDA-01636
Power Rail Noise Analyzer Reference Design

Description
This reference design is an active pass-band filter
connected to the analog-to-digital converter (ADC) in a
C2000™ microcontroller (MCU). The system senses
ripple and noise on the power rail in the band of
interest. The Fast-Fourier Transformation (FFT)
algorithm analyzes harmonic content of the signal and
allows for switching frequency detection. The analysis
enables for adaptive real-time switching frequency
dithering in high-power applications and better
electromagnetic compatibility interference (EMI)
control. Alternatively, ripple counters in feedback-less
positioners can benefit the design.

Digital Signal Processing (DSP) features of C2000™
microcontrollers play an important role in the system
and enable digital-power (on-board chargers, DC-DC
converters) and motor control (traction inverters)
applications to become smarter and more efficient.

Resources

TIDA-01636 Design Folder
OPA365-Q1 Product Folder
TMS320F28069M Product Folder

ASK Our E2E™ Experts

Features
• Multiple Feedback Filter (MFB) Topology
• Single-Supply Power
• Example Firmware for TMS320F28069M C2000

MCU Including Source Code

Applications
• HEV and EV - Inverter and Motor Control
• HEV and EV - DC/DC Converter
• Various RippleCounters

An IMPORTANT NOTICE at the end of this TI reference design addresses authorized use, intellectual property matters and other
important disclaimers and information.

http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDUE67
http://www.ti.com/tool/TIDA-01636
http://www.ti.com/product/OPA365-Q1
http://www.ti.com/product/TMS320F28069M
http://e2e.ti.com
http://e2e.ti.com/support/applications/ti_designs/
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1 System Description
The TIDA-01636 reference design consists of an active multiple feedback topology (MFB) pass-band filter
and a host MCU. Input of the filter connects to the in-vehicle voltage rail. The filter passes and amplifies
the signal in the band of interest. The board connects to the LAUNCHXL-F28069M LaunchPad™
Development Kit with the TMS320F28069M host microcontroller from the C2000 family. The
microcontroller uses the integrated ADC for signal conversion and performs FFT. This process builds
magnitude spectrum of the voltage rail ripple. The host system in an HEV or EV vehicle can use the
information for smart control of other in-vehicle systems.

Figure 1 shows the reference design from the top and the bottom side.

Figure 1. TIDA-01636 Board (Top and Bottom)

1.1 Key System Specifications

Table 1. Key System Specifications

PARAMETER SPECIFICATIONS
Input Supply Voltage 3.3 V or 5 V from the LaunchPad Development Kit
Input Signal Amplitude Maximum 170 mV p-p

Filter Bandwidth 77.8 Hz to 1.19 MHz
Filter Gain 25.73 dB (pass-band)
Filter Order 1st order high-pass filter, 2nd order low-pass filter
FFT Stages 10
ADC Sample Rate 1.75 MSPS (up to 3.46 MSPS)
ADC Buffer 2048B
ADC Resolution 12 bit
ADC Reference Integrated, 3.3 V
Form Factor 2-layer PCB 50 mm × 30 mm
Interface Code Composer Studio™ (CCS) software

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDUE67
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2 System Overview

2.1 Block Diagram
Figure 2 shows a block diagram of the TIDA-01636 reference design and the typical implementation in the
system.

Figure 2. TIDA-01636 Block Diagram

2.2 Highlighted Products

2.2.1 OPA365-Q1
The OPAx365-Q1 zero-crossover family, rail-to-rail, high-performance, CMOS operational amplifiers are
optimized for very low voltage, single-supply applications. Rail-to-rail input/output, low noise (4.5 nV/√Hz)
and high-speed operation (50-MHz gain bandwidth) make these devices ideal for driving sampling data
converters (such as the ADS7822-Q1 or the ADS1115-Q1 devices), specifically in short to mid-range
radar applications. The OPAx356-Q1 family of operational amplifiers are also well-suited for HEV or EV
and powertrain applications in DC-DC converters and as transmission control in engine control units.

Special features include an excellent common-mode rejection ratio (CMRR), no input stage crossover
distortion, high input impedance, and rail-to-rail input and output swing. The input common-mode range
includes both the negative and positive supplies. The output voltage swing is within 10 mV of the rails.

The OPA365-Q1 device (single version) is available in the 5-pin SOT-23 package. The OPA2365-Q1
device (dual version) is available in the 8-pin SOIC package. All versions are specified for operation from
−40°C to 125°C. Single and dual versions have identical specifications for maximum design flexibility.

2.2.2 C2000™ TMS320F28069M MCU
The F2806x Piccolo™ family of microcontrollers (MCUs) provides the power of the C28x core and control
law accelerator (CLA) coupled with highly-integrated control peripherals in low pin-count devices. This
family is code-compatible with previous C28x-based code, and also provides a high level of analog
integration. An internal voltage regulator allows for single-rail operation. Enhancements have been made
to the high-resolution pulse-width modulator (HRPWM) module to allow for dual-edge control (frequency
modulation). Analog comparators with internal 10-bit references have been added and can be routed
directly to control the ePWM outputs. The ADC converts from a 0- to 3.3-V fixed full-scale range and
supports ratio-metric VREFHI and VREFLO references. The ADC interface has been optimized for low
overhead and latency.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDUE67
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2.3 System Design Theory

2.3.1 Pass Band Filter Design
Figure 3 shows a circuit diagram for the pass-band filter. The filter splits in two parts:
• High-pass filter (1st order, –20 dB/dek)
• Low-pass filter (2nd order, –40 dB/dek )

Figure 3. Pass-Band Active Filter in TIDA-01636

The input signal connects to the filter through the terminal block J2. Alternatively, the BNC connector J1
serves this purpose during circuit debugging.

The coupling capacitor C2 and input impedance of the subsequent active filter define the high-pass cutoff
frequency. Some assumptions can be made to simplify input impedance calculation. The cutoff frequency
for the high-pass filter is significantly lower than the cutoff frequency for the active low-pass filter. For this
reason, the analysis can ignore capacitors C1 and C4 and treat them as an open circuit. In this case,
resistor R5 is in series only with the inverting input of the operational amplifier U1 and can be ignored as
well. Using this simplification turns the circuit into an inverting amplifier where resistors R4 and R3 set
gain. Resistor R4 is then the effective input impedance. These assumptions set cutoff frequency of the
high-pass filter as per Equation 1. It is important that the voltage rating of the capacitor C2 is higher than
maximum DC voltage from the signal source.

(1)

The cutoff frequency of the low-pass filter is independent of the C2 selection. Resistors R3 and R4 set the
gain for the band of interest as per Equation 2.

(2)

Equation 3 defines the cutoff frequency for the MFB low-pass filter.

(3)

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDUE67
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The resistor divider R6, R7 creates a virtual ground for the single-supply filter. Capacitor C6 reduces the
noise on the non-inverting input pin of the operational amplifier. Capacitor C5 is a bypassing capacitor for
U1. Resistors R1 and R2 are power-supply selectors which enable power either from the 3.3-V or 5-V rail
from the C2000 LaunchPad.

NOTE: The cutoff frequency is typically identified as the point where the transfer function of a filter
drops by –3 dB. This drop corresponds to approximately half of the power transfer. However,
higher-order filters have a steeper rolloff (for example: –40 dB/dek for a second-order filter)
and the cutoff frequency is defined as n(–3 dB) where n is the filter order. This definition
often causes confusion because some technical articles or online calculators use formulas
referring to the –3-dB point; whereas, others use n(–3 dB). Check the calculation using a
simulation tool.

2.3.2 Firmware
Embedded firmware for the C2000 LaunchPad development board uses the FFT function from the FPU
DSP Software Library from Texas Instruments which is a part of controlSUITE™ software package. The
typical installation path is "C:\ti\controlSUITE\libs\dsp\FPU\v1_50_00_00\include\". Documentation for the
library is typically found at "C:\ti\controlSUITE\libs\dsp\FPU\v1_50_00_00\doc\FPU-SW-LIB-UG.pdf". Refer
to the manual for details on how to use and configure FFT routines used in the reference design.

Figure 4 shows a flow diagram of the source code. The MCU uses a Direct Memory Access (DMA) unit for
automatic transfer of ADC data into a buffer. The main loop waits until the DMA fills the buffer and
calculates FFT based on the configuration. A user has access to FFT data through Code Composer
Studio (CCS).

Figure 4. TIDA-01636 Firmware Flow Chart

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDUE67
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2.3.3 Aliasing
Every analog-to-digital conversion system must consider the aliasing phenomenon to process data without
distortion. This phenomenon causes every spectral content with frequency higher than half of the ADC
sampling frequency wrapping around this frequency and starting affecting the band of interest. This
corrupts data. The ADC sampling frequency must be at least twice the highest frequency of the input
signal spectrum. Refer to for more details on aliasing and anti-aliasing filters.

Figure 5 shows the effect of aliasing.

Figure 5. Aliasing Effect and Filter Response

Ideally, the low-pass filter passes every spectral content up to the half of sampling frequency. All spectral
content above is suppressed to zero. However, a real filter has limited roll-off slope (for example, –20
dB/dek, –40 dB/dek) which corresponds to the filter order. For this reason, the filter may not sufficiently
suppress harmonics above the half of switching frequency and they fold to the band of interest. This
causes data corruption. Selecting the proper filter order, bandwidth, and sampling frequency typically
requires some trade-offs. The anti-aliasing filter should be set in the way that all aliased spectral content is
close to native noise level or below resolution of the system.

There are integrated analog filters which are close to the ideal "brick-wall" response but they are
expensive. Note that the digital filter in the MCU does not help to avoid aliasing. The system must
implement a low-pass filtering in the analog domain before analog-to-digital conversion.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDUE67
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3 Hardware, Software, Testing Requirements, and Test Results

3.1 Required Hardware and Software

3.1.1 Hardware
To start with the TIDA-01636 reference design:
1. Plug the reference design to the LAUNCHXL-F28069M board. The correct position of the PCB is

shown in the circuit diagram.
2. Connect the LaunchPad with the reference design to the personal computer using the provided USB

cable. LEDs on the LaunchPad show activity.
3. Use twisted wires for connecting the terminal J2 to the analyzed voltage rail. Alternatively, use the

BNC connector J1 as the signal input.

3.1.2 Software
The reference design requires the Code Composer Studio (CCS) development tool for uploading the code
example to the MCU and displaying the data. Use the following procedure to upload and run the firmware:
1. Install Code Composer Studio which is available from www.ti.com/ccs. Make sure that you select the

C2000 compiler and XDS100 drivers during the installation.
(The CCS 7.4 and TI v16.9.1.LTS compiler were used for the TIDA-01636 development).

2. Import the provided firmware from File->Import->CCS project menu.
3. Try to compile the code (Project->Build All from the menu). Make sure that compilation passes without

any error or warning. If there are missing resources (libraries), download and install C2000 Ware from
www.ti.com/tool/C2000WARE.

4. Run the project from the Run->Debug menu. This programs the microcontroller.
5. Start code execution from the Run->Resume menu.
6. Show a graph plot from the Tools->Graph-Single Time menu. Fill in parameters in the dialog as

Figure 6 shows.

Figure 6. Graph Settings in Code Composer Studio™ for TIDA-01636

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDUE67
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http://www.ti.com/tool/C2000WARE
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7. A graph appears after confirming the previous dialog. Make sure that you enable continuous refresh by
clicking on the icon. You can export data to .csv format and import them to programs such as
Microsoft® Excel® or MATLAB®. Figure 7 shows an example of the plot in CCS. The example shows an
FFT plot of a sinewave with Vamp = 80 mV and f = 100 kHz.

Figure 7. Graph in Code Composer Studio™ Showing 100-kHz Sinewave Magnitude Spectrum

NOTE: For detailed tutorials on how to program, compile, and debug using TI's MCUs, see
processors.wiki.ti.com. Alternatively, TI also offers live support within the E2E™ online
community.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDUE67
http://processors.wiki.ti.com/index.php/Main_Page
http://e2e.ti.com/
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3.2 Testing and Results

3.2.1 Test Setup
The test setups consists of a personal computer running Code Composer Studio, TIDA-01636 reference
design connected to the LaunchPad, and the source of a signal. Measurements in this section use various
evaluation modules with DC-DC converters.

Figure 8 shows an example of a typical test setup.

Figure 8. TIDA-01636 Test Setup

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDUE67
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3.2.2 Test Results

3.2.2.1 TIDA-01636 Low-Pass MFB Filter Response
Figure 9 shows the TIDA-01636 filter gain and phase measurement data.

This measurement uses a 2.2-µF capacitor in place of C2. This increases the cutoff frequency for the high-pass filter
to fc = 117 Hz.

Figure 9. TIDA-01636 Filter Gain and Phase Response

http://www.ti.com
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3.2.2.2 TIDA-01636 With LM20242EVAL
Figure 10 shows an FFT plot from the TIDA-01636 connected to the LM20242 evaluation board. The
evaluation board operates in the following conditions:
• Input voltage: 16 V
• Output voltage: 3.3 V
• Load: 1 A (constant conduction mode - CCM)
• Switching frequency: nominal 300 kHz

Figure 10. FFT Analysis of LM20242 Evaluation Board Running at 300 kHz in CCM

Figure 11 shows the output ripple of the LM20242 evaluation board in the time domain.

CH1 - Voltage ripple at the output capacitor measured with 1:10 oscilloscope probe with spring ground terminal.
CH2 - Signal at the input of the TIDA-01636.
CH3 - Signal at the output of the TIDA-01636.

Figure 11. TIDA-01636 and LM20242 EVM Waveforms (CCM)

http://www.ti.com
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3.2.2.3 TIDA-01636 With LM3100EVAL
Figure 10 shows an FFT plot from the TIDA-01636 connected to the LM3100 evaluation board. The
evaluation board operates in the following conditions:
• Input voltage: 16 V
• Output voltage: 3.3 V
• Load: 1 A (constant conduction mode - CCM)
• Switching frequency: nominal 250 kHz

Figure 12. FFT Analysis of LM3100 Evaluation Board Running at 250 kHz in CCM

Alternatively, Figure 13 shows the board operating in discontinuous mode (DCM).

Figure 13. FFT Analysis of LM3100 Evaluation Board Running at 250 kHz in DCM

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDUE67
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Figure 14 shows the output ripple of the LM3100 evaluation board in the time domain when operating in
CCM.

CH1 - Voltage ripple at the output capacitor measured with 1:10 oscilloscope probe with spring ground terminal.
CH2 - Signal at the input of the TIDA-01636.
CH3 - Signal at the output of the TIDA-01636.

Figure 14. TIDA-01636 and LM3100 EVM Waveforms (CCM)

http://www.ti.com
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3.2.2.4 TIDA-01636 With LM3150EVAL
Figure 15 shows an FFT plot from the TIDA-01636 connected to the LM3150 evaluation board. The
evaluation board operates in the following conditions:
• Input voltage: 13.2 V
• Output voltage: 3.3 V
• Load: 2 A (constant conduction mode - CCM)
• Switching frequency: nominal 650 kHz
Note the aliased 2rd and 3rd harmonics.

Figure 15. FFT Analysis of LM3150 Evaluation Board Running at 650 kHz in CCM

Figure 16 shows the output ripple of the LM3150 evaluation board in the time domain when operating in
CCM.

CH1 - Voltage ripple at the output capacitor measured with 1:10 oscilloscope probe with spring ground terminal.
CH2 - Signal at the input of the TIDA-01636.
CH3 - Signal at the output of the TIDA-01636.

Figure 16. TIDA-01636 and LM3150 EVM Waveforms (CCM)

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDUE67


Frequency (MHz)

R
el

at
iv

e 
A

m
pl

itu
de

 (
-)

0 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9
0.02

0.1

1

10

100

1000

D007

www.ti.com Hardware, Software, Testing Requirements, and Test Results

15TIDUE67–June 2018
Submit Documentation Feedback

Copyright © 2018, Texas Instruments Incorporated

Power Rail Noise Analyzer Reference Design

3.2.2.5 TIDA-01636 With LM5001 Flyback
Figure 17 shows an FFT plot from the TIDA-01636 connected to the LM5001 Flyback DC/DC converter.
The DC/DC converter operates in following conditions:
• Input voltage: 24 V
• Output voltage: 2 × 5 V (isolated)
• Load: 0.5-A discontinuous mode - DCM)
• Switching frequency: nominal 100 kHz

Figure 17. FFT Analysis of LM5001 Flyback DC/DC Converter Running at 100 kHz in DCM

Figure 18 shows the output ripple of the LM5001 Flyback DC/DC converter in the time domain when
operating in DCM.

CH1 - Voltage ripple at the output capacitor measured with a 1:10 oscilloscope probe with spring ground terminal.
CH2 - Signal at the input of the TIDA-01636.
CH3 - Signal at the output of the TIDA-01636.

Figure 18. TIDA-01636 and LM5001 Flyback DC/DC Converter Waveforms (DCM)

http://www.ti.com
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3.2.2.6 TIDA-01636 With LMZ14203HEVAL
Figure 19 shows an FFT plot from the TIDA-01636 connected to the LMZ14203 evaluation board. The
evaluation board is used in following conditions:
• Input voltage: 16.3 V
• Output voltage: 12.0 V
• Load: 2 A
• Switching frequency: nominal 400 kHz

Note the aliased harmonics.

Figure 19. FFT Analysis of LMZ14203H EVM Running at Nominal 400 kHz

Figure 20 shows the output ripple of the LMZ14203H evaluation board in time domain.

CH1 - Voltage ripple at the output capacitor measured with a 1:10 oscilloscope probe with spring ground terminal.
CH2 - Signal at the input of the TIDA-01636.
CH3 - Signal at the output of the TIDA-01636.

Figure 20. TIDA-01636 and LMZ14203H EVM Waveforms

http://www.ti.com
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3.2.2.7 TIDA-01636 With TPS92692EVM-880
Figure 21 shows an FFT plot from the TIDA-01636 connected to the TPS92692 evaluation board. The
evaluation board operates in following conditions:
• Input voltage: 12.0 V
• Full brightness
• Switching frequency: nominal 390 kHz
• Boost configuration
• Dither modulation frequency: 600 Hz

Figure 21. FFT Analysis of TPS92692 EVM Running at Nominal 390 kHz With (Blue Trace) and Without
(Red Trace) Spread Spectrum Modulation

http://www.ti.com
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Figure 22 shows the output ripple of the TPS92692 evaluation board in the time domain.

CH1 - Voltage ripple at the output capacitor measured with a 1:10 oscilloscope probe with spring ground terminal.
CH2 - Signal at the input of the TIDA-01636.
CH3 - Signal at the output of the TIDA-01636.

Figure 22. TIDA-01636 and TPS92692 EVM Waveforms

3.2.3 Conclusion
The TIDA-01636 reference design proves the concept of using a band-pass filter with FFT analysis for
disturbances identification on a power rail. The reference design works well with signal sources operating
in the lower range (<100 kHz) of the band of interest. Analysis of DC/DC converters operating with higher
frequencies (>100 kHz) suffer from aliasing. TI recommends adding additional low-pass filters in-series
with the output of the reference design as well as increasing sampling frequency, if possible.

http://www.ti.com
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4 Design Files

4.1 Schematics
To download the schematics, see the design files at TIDA-01636.

4.2 Bill of Materials
To download the bill of materials (BOM), see the design files at TIDA-01636.

4.3 PCB Layout Recommendations
The TIDA-01636 reference design does not require any special PCB layout considerations. The PCB has
two layers with 35-µm copper plating. The top layer (Figure 23) is reserved for components and signal
traces. The bottom layer (Figure 24) provides the current return path - signal ground.

Figure 23. TIDA-01636 PCB Composite Top View

Figure 24. TIDA-01636 PCB Composite Bottom View
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4.3.1 Layout Prints
To download the layer plots, see the design files at TIDA-01636.

4.4 Altium Project
To download the Altium Designer® project files, see the design files at TIDA-01636.

4.5 Gerber Files
To download the Gerber files, see the design files at TIDA-01636.

4.6 Assembly Drawings
To download the assembly drawings, see the design files at TIDA-01636.

5 Software Files
To download the software files, see the design files at TIDA-01636.

6 Related Documentation

1. Texas Instruments, Aliasing and Anti-aliasing Filters, Peggy Liska

6.1 Trademarks
C2000, E2E, LaunchPad, Code Composer Studio, controlSUITE are trademarks of Texas Instruments.
Altium Designer is a registered trademark of Altium LLC or its affiliated companies.
Microsoft, Excel are registered trademarks of Microsoft Corporation.
MATLAB is a registered trademark of The MathWorks, Inc..
All other trademarks are the property of their respective owners.
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